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�د
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:ا	+ ���ب ��رد ا#�(�د�
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����� �����

Visio 4نحوه ايجاد يك فايل جديد در

6 بالا بردن دقت در رسم اشكال

7 رسم محورهاي مختصات

7 چرخش يك شكل تحت يك زاويه دلخواه ومركز ثقل مشخص

8 ترسيم اشكال متشابه با مركز يكسان

9 ابزار ترسيم

10 هاشور زدن يك ناحيه مشخص

10 جهت دار در جايگاه هاي مختلفرسم خطوط

و زاويه قائمه 11 رسم خطوط عمود بر هم

12 رسم چند ضلعي هاي منتظم با مركز يا بدون مركز

12 معرفي ابزارهايي جهت رسم انواع مثلث ها

12 نمادهاي هندسي

و محيطي 13 رسم دايره هاي محاطي

14 نوشتن رئوس اشكال هندسي

14 صورت براكت در كنار اشكالنوشتن توضيحاتي به

15 اندازه گيري زواياي رسم شده

و قطر دايره 15 اندازه گيري شعاع

16 رسم يك استوانه
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17 رسم يك منشور

ها رسم اشكال 18 مربوط به مجموعه

18 نحوه گروه بندي اجزائ رسم شده

19 رسم يك مكعب

21) سوم رياضيسال-دبيران درس مباني علم رايانه(لوچارتفرسم

22 تعريف زبان فارسي براي سيستم

و فرمول ها به صورت فارسي Office 2007(24( نوشتن اعداد

Office 2007(25( فارسي نوشتن فرمولها در

و فرمول ها بايد در محيط  Visioتغييراتي كه براي فارسي نوشتن اعداد

.اعمال شود
26

Visio 28فارسي نوشتن اعداد در متون

word 29انتقال اشكال ترسيمي به فايل

30 رسم يك نيم كره

31 رسم سطح مقطع يك منشور با قاعده دلخواه

 34تعريف يك استيل بدلخواه كاربر

35 حركت يك شكل
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 �� ��م H�ا

�I ��#رت د�K �� �
��� �� در ���	 �� �LMN�� ر�O#� د�ل ه1�N
ا��.�11��� �� را Q�#�L د���ان ه!�ار� در ر#Q ا
و �.�ارR.را در�L	V #�اUت ا�����T ��-�ف �1�ان � �L��L �� Rا�� ���ز د�����Visioم ا67ار  W��8� +	ا ����8� ��

و �QX دار،ا���Nر،�� �Lا��� ا
�Nل  Y8$� ��1� Q#را ر .

Rم ا67ار�� ������Visio، WZ� از ��
�د�  Microsoft Office ������ ز	� � �.]�T� +	 ا ��اR وارد 
�ن ��
.��ا�^ ز	� را -� �1��

Start       → All programs       → Microsoft Office  → Microsoft Office Visio 2003  

�� ا�iاR ��ا�^ �7ق ،��X1g اR ��ز �� 
�د �� �$�� �� ���ز�Lن �� �Lا��� 	�N از 

� ه� را �gب�j�ا� �. �kار ده��در ���

7�Mا�m. را ا���jب ��د� ��X1g �L اK/� ��ز 
�دTemplateدر ���/� ��� 	�N از 
+N	I ��ا��L ��،�	ار�� �K�H �
�g ب�j�ا� �� Q�!ZL وارد �L ��1� ب�j�را ا� 

�
در.�	������  � g VO����را	+ ����،دا��!# ��T� �!
 ���ن داد� �� 
�د �� �� 

�د�
�وع ��ر را �� ��o�.

��X1g م را در��g +	ا ��Rه� Q	ن داد� ا��� �	دو. ز 
� ه� ���نا��روش،ادر ه��g ع
.داد� �� 
�د

Rه� �
�g ب�j�ا� �� �!
Flowchart)رت�O�/7(،Block Diagramt)�#�1ل ه�N
و) ا

Charts and Graphs )و) �!�داره� . �!�داره� را ر#�1� Q��kدر ه$��� �� �O�/7رت،ا
�Nل ه1�#�

� ��ز ��دن 	�7 5	i ^�	� �� �Lا�����i��1	6m�� را �	از دو را� ز �N	.

)٢()١(
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�
� در ��ار ���Standard �1	� ا�6ار)١(در ����� ��
	�T)K 5 #(�� 	� ��~5 د	�� �� 
�د در ه� ��ل.�{�ر دا
� ���� ]�T Q#ر �T)K +	ا Rل را رو�N
و 
!� ا 
!� �T$�ب �� 
�د Rر�1�� ��.
.نحوه فراخواني ابزارهايي كه در رسم اشكال مي خواهيد در معرض ديد شما باشد�

Tools  → Customize….→ Toolbars    

 با كليك كردن درون:راه اول

مربع ها ابزارهاي مورد نيازتان

.انتخاب كنيدرا 

 درون مربع هايي كه در كنارگزينه هاي. كليك راست كنيد،درفضاي خالي نوار منو در بالاي صفحه: راه دوم

Standard ،formatting ،Drawing ،Format shape ،Snap&Glue 

. قرار دارند ،كليك كنيد تا علامت تيك ظاهر شود

��ا
�Nل� ��
و دار��ر��� درون �T)K ��ر�T8# ،R درگ 
Rر�� �T)K �1�دز��

!� د	�� �!�  ��
 Q#ل ر�N
 ا�m ا

، �1
�� ��
� ����� د	�� �!� ه!��
��� دا!$k �8ط ا-�افH
���
.N
� ه�R ����� ا!$k �� Q�1� ر�NO؟���
 �ل د	�� 

+N	I ^N�� +	ر7, ا Rب ��ا�j�را ا��1�� �Noو Iن را در ��� Fill ار�k 

وا	+ ��ر ���4 �� 
�د �� �T)K ��رR.ده�� Y8#، ���N
را �� �� ا	+ 
T� ^N�[ ا

������Hرد دار��  �.،��k^ رو��
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� ه�R ����� دو 
N/� �� �� ه�H�� Qرد!$k �L �ا�~�� را� دو�� هQ ه$
�1
�� �.دار�� ��k^ رو��

:���ل�1
�� ��
� ����� هQ دا!$k �� ��1� Q#ر ��	دودا.�� ه!�ن -�ر
���
.���ه�� �� ��1� !$k���R ����� د	�� �!� 

در.�� �Lا��� ه� دو 
N^ را �� هQ ا���jب �1�� �Lر�K ر�� �� �	ه� ,���
در �����N ا
�Nل در ���� ا���jب 
�� �kار.��1ر ه�دو 
N^ د	�� �� 
�د 

. را -� �1��ز	�دار��،را� 

Shape→ Operations→ join 


�����#�	,،�� ر�� #�8ح ه� دو 
N^���ه�� �� �1�� �� W���L Qه �� ^N
و ه� دو  
N^.ر�� �� 
�د �mا
���
و از #8^ ر�� هQ ا#�(�د� ��1�!$k،���R ��� ����� ر�� ��  .���	� را در ���� ا���jب �kار ده��

�Rا������� �kاد را Ruler & Grid ��اR ورود �� ������ 6m	��1 در ر#Q ا
�Nل، ���� ا#� �� در
ه�در ��X1g رو��و ��	�.7��ل �1��  در �T)K ��ر�H 5�L Ruler & Grid Rرد� ��
1� �L ��1ر���,
���

�X��8 را از ا	+ -�	�
!� �� �Lا���.د	��  Rه� ���H از��ا��1�� Q��1L .

.Tools →Ruler &Grid…. 

��X1g در �� �Lا����L ���	ز )Ruler &Grid(��
،ا#�داد� 

��� ����# 5	 5~�� Rه� ���H و �4ض در ��� 7�m�� -�ل
�
�� ا#.

�� ]H �!
 Ruler ن را��	ر�� �T)K VO �و #! U�� در ��
وا��ه�	� �� �� روH R[ �� �!�	� داد� در ��X1g ز	�.��1��

��
 ��7�m ��� در ��� ��5 #��	ز �� �
�� ا#.
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�� Standardدر ا�6ار� 
� I	�1N و�iد دارد�� �� Rر�� �T)K 5 ���ن دادنO�� و  �� �� �$W ����ط �� �6رگ
.���ن �� ده�درK� Iن را

 ��اR ر#�T� Qر �j��Zت �� �Lا����

. را -� �1��رو��و ��ا�^

دو ���, #~6.��اR �6رگ ��دن �8Hط از �T� �/!iره� Uزم ا#� �� H[ را ا���jب �1���
ا.و ا����H R[ ��ه� �� �mددر�� ��5O در ا���ا Rار دادن ��وس رو�k �� ا����� �	 

.ا67ا	� ده���� درگ ��دن Iن،ا�����L �� ]H Rا��� �� ا��از� د��jا� -�ل H[ را

������،��1� V	�L را Rد�4 �/K�7M� ]H Q#از ر ��� �mا visio ^Hد را دا�4 ،  ��8ر �Hد��ر
�1� �� +	6�	�i، ]H.

�O 
�� ��	� ا�H �mا#��ر�� ^N
 5	 �H� را ^N

N^د.�1��ا���jب  ,��� Rه� �����# ��Iن #~6 ر�  در ��Oر -�ف
دا	�� #~6 ر��� هQ د	�� �� 
�د �� ا�i �� �i �� �� .�m ��دن �L �� ���Iا��� ا��از� 
N^ را �L��� ده��د	�� �� 
�د

، 7/�،ا
�ر� �m ��وس را �� روI Rن �kار ده�� �/N
 Rا ��	هدا�� ^N
را� �� 
�د �� 
!� �� �Lا��� I ]#�Lن 
����H���.

�!
 �mا�� ا ^N
 �H�O ر��ا#�H/�و � �j�� از��ا� �� �����
�� �!/� R�/i در �ا��از� زاو	�، Angle،���7 ا#
 �H�O)M��٧٠�iرا)در�1�� +���L .�)K،��1� �� درگ ]�T� �� را ���I او��+ ��ر Rا�� �� Rا�6ار ���!L R زاو	�

�.ا#
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�L �� ،^Nا��� �� روR د#����� دورا�� Iن 1O� ���T ا
�ر� �m ��وس را ��� دار	�� 5	6 �.^ ��� �	�i �� �i Rا��
��1� �i ���i را ^N
و 
!� �� �Lا��� ���6 �.^  ا�m د#����� دورا��.�� در ا	+ �Kرت دا	�� ���NO ��ه� �� �mدد


N^ در ا-�اف ���6 �.^،����H��� دا(را��
.�� H�O� (	�� ��5O ��ه� 

دو� 
N^در ��{� ��ا�H �� ,kاه�������� 
�� ��
�از.)دودا	�� �� ��� 6	N$�ن ��M(��دا�K�ZH offset (�د��ا# 
Q�1� ��.

��1� �� �j�� او�� را ��	6 �� دا��� Qه ��	دو دا �/K�7 ��1� �� وارد �	در ��در ز �!
 �� Rد�4 ��.��� Qه ��	6 دو دا
و �� �Lا��� دا	��.ا	�j�� +�O �8.� �� Q ��د�،�� دا	�� او�� را . را �oف �1��ا���7ه� #� دا	�� از هi Q�ا ه$�1�

�+�� R .ز	� را -� ��د�^�ا����،�� �Lان��IاR ر#Q دو دا	�� هQ ���6 ،ه!�ا� �� R�}7 ه�
�ر �Hرد�
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و �� ا#�(�د� از ا�6ار� �1T1� �8طH،��	�8ط #�د� ،داH ��ا��L �� .... ل�N
 را ر#Q �1��، ا�� ا	+ ا

.د#����� ه�	� ��اR ا�ZLل �� ا
�Nل د	�� را ��ار��

. را ا���jب ��1� Drawingا�6ار. ،رو���H R�}7 R در ��ار ��1 �/�5 را#� ��1� ��DrawingاR د	�ن ا�6ار�

�5�/� �� �mدن �!�دا�� Drawiing��1� �-،�
�� ا# ����� �	�ZL �� �	، ��ا�/� را �� در ز��� ��	ا�6اره� د، .


� 	�N از ا	+ ا�6اره� �� 
N^ ��اد�� �� .

	�. دو دا	�� ر#�1� Q� ��Drawingا#�(�د� از ا�6ار:���ل و 
!� �Hا#��ر ر�� ��دن
�� �!$k ر زدن�
 ��� ه�

��
�� ��.�$�� �	og ن�N+ ��ر ا�	ا�� ا.R�1 ه�	6m م �!L ا��ا�، ^N�� +	ا ^� Rا�� 
Snap &Glue Q�1� �� ل����. را 7 #�¡ �� ا#�(�د� از ا�6ار ��اد،ا-�اف ����� اR را ��

 Q�1� �� Q#�8-� رH، Q��6� ر�� �	ر �
�� #8^ ر��. �Hاه�Q ه�� Q	�� �� ر�N� در. را،
���� �Lر�K�
�� ��$� M��� �� ����� ،�� د�
.� ر�� زد� �� 

.ا�� درر#�L ]H Q#[ ��اد ،ا���ا H[ را#� �� د#����� ه�R #~6 ر�� ��ه� �� 
�د
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�X��� �� ��ا��L �� ه� ����
!� �� �Hاه�� ��Iا ر�� ��1��1T1�، وار ا#�، �� �i �� �i ��دن د#� �� Rا ����� �mا
.�8/�ب ��#��

 ا�� �8Oر 	5 ����� را ه�
�ر �Q��6؟

�+N	I ، .را �/�5 �1����اR ه�
�ر زدن، ��� از ا���jب ����� ��رد ���

و 
!� �� �Lا��� 	�N را ا��اع ه�
�ره� ه!�ا� �� ر�� ز���1 در اH���ر 
!� �kار �� m��د
.ا���jب �1��

و ��� !"#��,��� ا��ار+ *( �)� را در ر�� دا'�
،ا�%اع ��* ��. .",� ه� *)- 

File→ shapes→ Visio Extra s→ Drawing Tool Shapes 

���i ���	�i �� Rدار ��i ]H Q#ر�L .�L��� ده����� ����jا�ارا ��
File→ shapes→visio Extras→CONNECTORS 

� را روH R[ در ��Nن د��jاه� �kار ده���i ��M4 ��اه�j� �mا.���i .�8 زرد ر�� را��1�� �i .

��K�H ازOffset ��1� (�د��ا# .]H دو
 �!
 �� Rا �/K�7 �� نI ازات�� �� ��د	


�د �� Q#ر، ��.]H� ����Lن ه$
.ا���7 را �� �Lا��� �oف �1��
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��ل�:،]H (�د� از دو�ا# ���1�� Q#ر �	5 زاو	.+N	I �� ا��I و .[ ��رR درگ ��1��T�را ا���jب �1��

~# Rدن ���, #~6 ر�� و#����7،�8, ه��� �i ���i �� و 6K�L ر�� را �� روR ا�Mع زاو	� �kار ده�� /� �!�ن را
��1� Q��1L از�.راس�ا� ����L Rزرد ر�� را ��ا ,���

 ��M4��1� �i ���i ��i.

File→ shapes→ Visio Extra s→ Drawing Tool Shapes 

از� .� ر#�1� Q��� �Lا��� زاو	� I!��k	N+ �� ا#�(�د�

�+N	I (�د� از�ا# ���1�� Q#ر Q�8ط 4!�د �� هH ��ا��L �� .�� �� �i �� �i	� ���, زرد ر��

و�Lا��� � H[ 4!�د را �L��� ده�� ا��از���k�� .

�+N	I �mا ا��ا� �درگ �1� Rر�� ]�T� �� را 

را. �� 
�د ��/� د	�� و 	�N د	�� ازا
�Nل ��1� ��/� �/�5 را#� Rرو ��
.ا���jب �1��

�+N	I از �1�� Q#ع رM� Uا �/�j� �/�#� #� �.�8 زرد ر���1�� ،��ا#�(�د� ا�j� �mاه�� �  در
 راس

�/�،ا	+ �.�ط زرد ر�� �� �Lا��� �� درگ ��دن. ��ه� �� �mدد � .ا��از� �/, را �L��� ده���� R�i د��jا�



12 
 

�+N	I ب�j�ا� ���1�� Q#ن ر�$N	 ��4�k �� �	ه� �/�.�� �Lا��� �

�+N	I ب�j�د��� ا��� �	5 زاو	 �� Rا �	ا�6او Q��k �/�. ر#�1� Q� ���L ���jا��� �

 �� �Lا��� ��/� Q��k ا�6او	� �� دو I	N+ �� ا���jب�

/���1� Q#م را ر�/��� �i ���i ��دن �.�8 زرد ر�� �� �Lا���., �
.ا�Mع را �L��� ده��


�د �� �j�� �/��� دار	� ،��ع �� ��T� �1O �/��/� Q��k ا�6او	�.ا�m ا
�ر� �m ��وس را روR ا�Mع �� �mاRtو
�mازا�
�� ��. ��ه� �� 
�دTriangle ��ع ه�R د	

در� . ا	+ ا�6ار �� �Lا��� $i��X �1���!�ده�R ه1�#� را
File → shapes→ Mechanical Engineering→Geometric  Dimensioning   and   Tolerancing 

+N	I ازParallelism��1� Q#را ر Rاز�� ]H دو �ا���L �� .از
.�8H �H�Oط ��ازR ا#�(�د� �1��ود#����� ه� ��اR �6رگ ��دن
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و محيطي رسم دايره محاطي�

File→ Shapes→ Block Diagram→ Basic Shapes 
، مربع يا هر چند ضلعي را كه مي خواهيد، به محيط كاري درگ كنيد.1 .ابتدا مثلث

ا. بگرديد نبالد به Basic Shapesدر همان ابزار.2 ي با در واقع شما دايره

.لخواه رسم مي كنيددشعاع

به.در ضمن درگ كردن، مركز دايره را بر روي مركز چند ضلعي قرار دهيد.3 اگر هر دو مركز بر هم منطبق شوند علامت دو مركز

.رنگ قرمز در مي آيد

در قدم بعدي دستگيره سبز رنگ دايره را جابه جا

.كنيد

 اگر دستگيره سبز رنگ را به روي يكي از راس�

 هاي مثلث قرار دهيد ،دايره بر مثلث محاط

.مي شود

.اگر دستگيره سبز رنگ را بر يكي از ضلع هاي مثلث عمود كنيد، ،دايره درون مثلث محيط مي شود�
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�����O ،ا���	داد� ا ����L ا��j��� را �	و زوا ��م ر��س 
!� �L �� ��ل ا
�Nل ه1�#� را �7ا�Hا�� ��د� ا	�،ا��از� ا�Mع
 	� �8Hط را ��1	Q�$؟


�+ ��م ر��س ا#�(�د� �1��از ا�6ار�� Rا��.

]�T� 5 �/�5 #�د� در	و  ، ��درR در اH���ر 
!� �kار ��visio ا���jب 6m	�1 �7ق
.�� m��د و
!� �� �Lا��� ه� �8/~� را داI ^Hن ��1	$��

��L،فo�،�	�i ���i Rو��ا ���j� ��� ... از ا�6ار �	ه� ،�� +�� �/!i ه� �����4 از�(�د� �1��ا#.
�^N

�+ �L�T���L در ��1ر �� 

File→ Shapes → Visio Extras → Callouts 

و درگ ��دن ��ا�� ��رد.را ���ه�� �� ��1�bracket (( �� -� ��دن ��ا�^ رو��و ا��اع ��ا�� ه� �� از ا���jب�
و ا	1O �N1� �gرا�mاف ��� +�� R��m ار�k ��i،��1� �
�� ا#�،ا�m �/�5 را# ��7�m ��� در +�� Rا�� �� ��!$k در ،


� را، �� �Lا��� ا���jب �1����.�mاText Parallel �mو ا ^N
 Text Perpedicular را ا���jب �1��،��+ �� ��ازات 
.را ا���jب ��1� �� �Kرت #���� �kار �� m��د

�Rا��R��m از��ا� ��
 Q#ر R�	زوا�4!^ �1� �	ز �1��� �ا���L �� .

File → shapes→ visio Extras→Drawing Tools Shaps   

. 	H 5[ ر#�1� Q�Drawing �� ا#�(�د� از ا�6ار

�� دار	�� ]H Rرو �� ��T� �1O وس را�� �m ر��
دا	�� ���NO در و#[ H[ �!�	�ن،ا�m ا
I ]#�L �� د�
.ن �� �Lا��� H[ را#� را ،��1T1 وار �1���� 
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��1� Q#دوم را ر ]H.

. �� �Hاه�Q ا��از� زاو	� ا	�Xد 
�� را ���Q�1� �~#�T ا�6ار

.در ا���اI	N+ ����-� را �� �T�[ درگ �1��
.��روR راس زاو	� ا�k �/Kار ده��،���, #~6 ر��� را�� در راس �kار دارد

� � ده�� �� �� رو R	�N از ا�Mع زاو	� اK/�،� روH R[ 4!�دR زاو	� �kار دارد�.�8 زردR را ����� �	�i �L 
.ه!��6ن �� ا	+ ��ر ،4�دR �� ا��از� زاو	� را ���ن �� ده� 1� �� ����L��k.ار m��د

را،�� �i ���i ��دن ���, زرد ر�� روH R[ ا7.� ���i ن دو�!� �/K�7 ��ا��L ���1� Q��1L 6��� �L�.
��1� �� Q��1L را +�� R�i ،�8#ر�, زرد ر�� و�� �	�i ���i ��.

 اندازه گيري شعاع دايره�

File → shapes→ visio Extras→Dimensioning-Engineering  

 

و ��Iا �� ���6 دا	�� �6د	5 �1��.	5 دا	�� ر#�1� Q� ��Drawing ا#�(�د� از ا�6ار .ا�6ار را ��دار	�

6m �mا R�1 ه�	snap &Glue �� و ا	+ 7��ل ��
� ،�� �6د	5 
�ن �� ���6 دا	�� ،���, 6��k ر��� د	�� �� 
�د
R�1�شد� .با جا به جا كردن نقطه زرد رنگ ،نوك فلش را تا محيط دايره بكشيد. مركز با نقطه شروع اندازه گيري استن چفت

.مربع سبز رنگي كه در كنار عدد مي بينيد ،متن را به جاي مناسب ببريدبا جابه جا كردن. اندازه گيري مي شود شعاعطول
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 اندازه گيري قطر دايره�

را.�1�� 	5 دا	�� ر#��Drawing Q ا#�(�د� از ا�6ار:���ل ��.��دار	� ا�6ار  ���, ���6 دا	���� �6د	5 
�ن
 6��k ر��� ��ه�

. د#���ن را از روR ��وس ��دار	�.�� 
�د

ز 
�وع �� 
�د. رد ر�� را T� �L�[ دا	�� درگ �1�� ���, �8k R��m از��زرد ر�� ،ا� ,��� �	�i ���i ��.

��1� �i �� �i + را�� �ا���L �� دن ���, #~6 ر���� �i ���i �� .

و شما مي توانيد متن ديگري را جايگزين كنيد،با انتخاب آيكن .متن در حالت انتخاب قرار مي گيرد

طا� آن ول يك پاره خط ندازه گيري و نوشتن مقدار اندازه گيري شده

.ابتدا استوانه را رسم مي كنيم.1

.را انتخاب مي كنيمابزار اندازه گيري فاصله.2

 دستگيره سبز رنگ را روي نقطه ابتدايي پاره خط مورد نظر براي اندازه گيري، قرار مي دهيم.3
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و بر روي پس دستگيره سبز رنگ دوم.4  را كه با مربع زرد رنگ بر هم منطبق شده اند ،پيدا كرده

و انتهايي پاره خط به صورت نقاط.نقطه انتهايي پاره خط قرار مي دهيم با اين عمل نقاط ابتدايي

.قرمز رنگي در مي آيند

و خطوط آبي رنگ را با استفاده از دستگيره.5 . هاي زرد رنگ تغيير دهيدبسته به نظر خودتان مي توانيد فاصله متن

.شكل نهايي مي تواند به صورت هاي زير باشد

را� و نقطه اي جهت رسم هرم مربعي منتظم كافي است كه مربعي را رسم كنيد

و هر  مي.. راس مربع را به نقطه فرضي متصل كنيد4بدلخواه در نظر بگيريد

. نشان دهيدتوانيد يالهاي پشتي را با نقطه چنين
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. ر#Q �1��را�� �Lا��� ا
�Nل ����ط �� �X!��4 ه� ز	��� -� ��دن ��ا�^�

)Drawing)Q�#�Lر#Q ا
�Nل ����ط �� �X!��4 ه� �� ا#�(�د� از ا�6ار�

��ل�:���!$k �}��L#[ ا�6ار Q�#�L #� دا	�� را ر#Q�1� �� Q ��8ر	�N �� هQ در �

�1�����.
�� Rا��+�� +N	I �4 ه�، از�!X� �}4+ ا�و �� Q�1� �� (�د��ا# 
+N	I (�د� از�ا# Q�1� �� �i ���i و و ا�m در 
N^ ا����ج. ��Iا ا���jب ��د�

+N	I را��8 ��د از ��Q�1� �� (�د��ا#.

���. ا�� ا	+ اL!�م ��ر ��$ و ��م �X!��4 ه� را ، ا4{�  �� 	� ا
�Nل

.�X!��4 وا�� در Iور	�KQرت 	�m 5و� 	�

ت 	5 
N^ �� ا	+ ��ر Q�#�L را �� را��� �� �Kر
Q�1� �� �i �� �i �وا�.^N
از -��7 ا�j� �mاه�� ا	+ 

��1� )copy-paste (�7��1� ^.�  Wordرا �� �7	^ 
� ^N
 Rوس را رو�� ،R�1� و��m از ¡g �.�	�~ا#


N^ ��وس �� �Kرت 	��O �/7 5ر �i�� در ��mه�
��I ��1� ��� ��7�� ن را درونI و ��1� � ،�/�5 را#

  �i Paste	� �� ���ز ه$�، ��Iا Wordو در �7	^
��1� .Q�م ده�Xرا ا� R�1� و��m ����O ا��.

 	5 �$�8�^ -�رR ر#Q�1� �� Qا���ا �� ا�6ار
و و را�[ ه�  ...�� L!�م ا6iاء 
N^ ،اQ4 از ��
�� ه�

8H. را در �� m��د .�ط �Kر�L ر��� در ا-�اف ا6iاء 
N^ ��ه� �� 
�د �� ا	+ 4!^

���
و د	��  و �/�5 را#� �1�� ا�� -�ر�8H �� Rط �Kر�L از ��+ ��ود 
N^ ��د� R+.��وس را رو	ا �N�Lر�K در
.�8Hط �Kر�L از ��+ ر7�1� ،دو��ر� 4!/��ت ا���jب 
N^ را ا��Xم ده��
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�1	6m �	از ز �.ا#�(�د� �1��را Group ه�،g¡ از �/�5 را#

و 
!� �� �Lا��� ا	+ 
N^ وا�� را دوران ده�� ،از ان 	5 ��� ��دار	� R�1� و��m از ���...... 

��L ز��iا �!
 �� ,kا�� �}�
!�.� داد� �!� 
�د�در �Kر�j� �N�Lاه�� ا6iاء ا	+ 
N^ وا�� 
�� را �L�� ده�� در �

N^ ��دا Rرا از رو R�1� و��m �و.ر	��X~�ر	� �� ��� ��1� 5�/� �
N^ وا��،را# Rرو �� ���اR ا	+ ��ر Uزم ا#

 �1	6m �	زUNgroupدد�m �� �� د�H ��6اء او�iا �� ^N

!� �� �Lا���. را ا���jب �1�� ،�� ا	+ ��ر  �در ا	+ ���
.�L���ات ��رد ���ز را ا��Xم ده��

و ��ر دار	�،�� �T)K ��رR ���ور	�� �# ���I �� �!از ه ��را �� ���� ���N

!� �� �Lا��� ا.
→  Fileا	+ ا
�Nل را د7��ت ��� در �$�� رو��و Shapes → Show Document Stencil 

و �� �T)K ��رR درگ �1�� 
�د Stencilا�~�� ا�m از ������ �Hرج 
�	� �T��	�ت.( ا���jب �� ��g (.

�W ��ا�^ ز	� را -� �1��:���لN� 5	 Q#ر Rا��.

File→ Shapes→Block Diagram→ Basic Shapes 

��R را ا���jب �Basic Shapes�1از ا�6ار� �# �~�i،�]�T� ^Hا �� دا��I و
.���رR درگ �1�

�W را �L��� داد�� �X��i ��دن �.�8N� ���N�#�g و .زرد ر�� �� �Lان ا��از� 	����

� �kار��gد ر و از -��7 	����	� �� �QX� W دار ���ن داد� 
�دN� �N1	ا Rا��
 ،���
 دار�� د	�� 

� �8Hط 	���� را …�L �� Snap & Glueا��� ��� از 7��ل ��دنkو �� د +�O �8.� رت�K ��
��1� Q#ر.

�	 راا�� �� . �oف �،Q�1� �8Hط ا���7

+N	(�د� از ا�را �� ا# ^N
�8Hط 
N^،�� ر��.ا���jب �� �Q�1ه!� 
�1	I �� در �Lر�K.

�1	6m ب�j�،�� ا� �1�ر�� ه$ �Lر�K ،�8طH �N���� درTrim �-�8H ��ا��L ��، 
و �� �/��  ،���I را�oف رو�/� �T)K R�Delرا �� �� ��� 
!� ا���7 ه$�1� ،ا���jب

��1�.
��oL:ر��د# �Lر�K درTrim �� �ه��k :Q^ ا#�(�د� ا# �� �-�8H �	 ���8#

 �1
�� ��

1�	� ���Hرد دا�� ,-�.��.
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�� �	�� ��، ��
� ه�j� R�/(� ا	�Xد !$k از �1�� �� �
!� در# �� �/N
ه� 
�	I در �وا� ^N
. �Kرت 	5 

� ^N
و ا	+ ��ر ��اR ا��.�ل  � داH^ �7	^ وردR �� در د#� دار	� Uزم
�.��ورR ا#

+N	I��1� ب�j�را ا�.�� ��1� Q#ر Rر�- ^N
�$�8�/� در ا-�اف 
�1	I در �Lر�K و ه!� �� ر�� 
N^ �/�5 را#�. L!�م ا6iاء را در �� m��د Rد دارد،رو�iو �Lر�K ر�� �N���� در

 ��1�.
�1	6m ب�j�ا� ��shape→Group  ن راI ��ا��L �� ��را� �� �� �	I �� �
N^ وا��R �� د# 
و ��1� �i ���i 

��1� ��� �k�� ��7�� ا در��I �	 .
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.با اين نرم افزار مي توانيد فلوچارتها را براحتي رسم كنيد�

با اجرا كردن برنامه در ابتدا ،پنجره اي مانند روبرو: راه اول

 را Flowchartد كه مي توانيد پوشه مربوط به ظاهر مي گرد

چارت در اختيار شما تمام ابزارهاي مورد نياز رسم فلو.باز كنيد

.قرار مي گيرد

در ابتداي ورود به محيط ،پوشه خاصي را انتخاب نكرده: راه دوم

و مستقيما   ايد

و بهازكافي است. رسم فلوچارتي هستيد خواهان وارد برنامه شده ايد ابزارهاي مورد راهي كه در روبرو به تصوير كشيده شده است

..نظر دسترسي پيدا كنيد

و چاپ را به راحتي مي توانيد با داشتن يك آيكن ، لوزي ، متوازي الا ضلاع اگر آن را درون.داشته باشيددر اختيار،اشكال مستطيل

با كليك،محيط كاري فراخواني كنيد 

.اوليه كه مستطيل مي باشد مي توانيد اشكال ديگر را انتخاب كنيدراست بر روي شكل 

د نياز را ذكر مي كنيم .با رسم يك فلوچارت تمام موارد مور
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o�1	6m �mاsnap &Glue��1� ل���� ا	+ ��ر�8H-� ��ه� �� 
�د �� 
!� را در�kار دادن ا
�Nل. 7��ل ��$� ��Iا 7
.� �� �1�درگ 
�� درون �T)K ��رR راه1!�	

o��ار ده�k د�H ���	�i ز �$»/� در��� �� ��ل ��رد ���ز را �$�N
.L!�م ا

oو شما صفحه مشبك را نمي بينيد ،كافي است اگر زمينه اشكال شما رنگي مي باشد

:كه

كه Fill Color آيكن.انتخاب كنيد همه اشكال را با استفاده از آن را انتخاب كرده ،بر روي مثلث كوچكي  در كنار

و Noرا يكجا در حالت اشكال انتخاب شده همه قرا ردارد كليك كنيد Fill قرار دهيد .

oدستگيره هاي سبز رنگي ظاهر مي شود(درون اشكال، كافي است كه شكل را انتخاب كنيد ساده براي نوشتن متني( و متن.

ان بطور خودكار متن را درون شكل  Visio.مورد نظر را بنويسيد و در . را فشار دهيدEnterها كافي است كليدتمي نويسد

و تغييرات لازمه را اعمال كنيد ا ست كه متن را در حالت انتخاب قرار دهيد و فونت متن كافي .براي تغيير اندازه

oاز)فرمول هاي رياضي( براي نوشتن روابط رياضي راهي كه در روبرو نشان داده بايد

ك .نيدشده است استفاده

 دقيقا درون شكل قرار نگرفته،ممكن است كه فرمول نوشته شده شما

 براي رفع اين مشكل.باشد

. را در نوار منو، فراخواني كنيدActionمانند شكل روبرو ،نوار.1

و شكل را همزمان در حالت انتخاب قرار دهيد  فرمول

چ(آنها موقعيت،و استفاده كنيداز آيكن )ين،وسط چين راست چين،چپ

.تنظيم كنيد را
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و شكل را از روش گروه بندي.2 از. به يك شكل واحد درآوريد فرمول  با اين تنظيمات ممكن است شكل شما

.ببريد اولشبا درگ كردن شكل نهايي،آنرا به جاي.جا به جا شودجايگاه اوليه خود

oل�ZLا ��i،د��ر�H ر�- �� R��� ^N
 �� ^N
 5	+N	I Connector Tool ل��7 � را در ���
.) در �� I	���ر��Xز��I �1	N+ �� ر�� .( �kار ده��

o^	�7 �� ا��I، �و �� رو
� �� M~k ذ�� 
�� ا# ��1� R�1� و��m �!�� ن راI رت�O�/7 Q#از ر ���Word ��� در �� 
.دار	� �1�.^ �1��

. را چاپ كند100كتر از فلوچارتي رسم كنيد كه مجموع اعداد طبيعي كوچ: مثال
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و ���7ل ه� در .�L���ات ز	� Uزم ا#� office 2007و��VisioاR �7ر#� ��
�+ ا4�اد

4,�'3 ز��ن ��ر�� ��ا+ ���01

، �� ��X1g ا�Zj�� �� Rت ز	� د	�� �� 
�ددر �g	���X1g + �7ق د�!� .را �/�5 �1��

، �� ا��6�ب د*)(, 4=�11ات ا';�د ��
 را �� 4%ا��Apply�1�1� �1� ا��6�ب د*)( . 4=�11اتِ ا';�د ��
 را اC)�ل *�Ok�1و در @%رت 4�?�1

��1� +���L ا��4ررا Rه� Qkاد ر��L.

��1� +���L اد �1(� را�د ا4�!�.

 رد ا#�(�د� در ��+ ار�kم�!�د ��

���+ �1���7م ا4�اد �1(� راL .

��1� +���L ا��4ر را ��M4.

�.����ط �� #��Q ا��از� R��m ا#

 ���T �!�	� ار�kم

�1	6m +	ا�ار ده��k �/� �.را در ���

.���T �!�	� رQk ه�	� �� در ��1ر هQ ه$�1�

� i�ا �11��$�� 
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)�'�E ا��6�ب �� Resetد%� �� )���E �Jض در��� L1M ف �)� �( @%رت�O از 
�� P11,4 ت�Q6R� .

ب و فرمول ها ) 2007office(ه صورت فارسي نوشتن اعداد

� U�� VO �� �/�5 �� روR �!�د!# �
�m در ��
�kار دارد،��X1g اR ��ز �� 
�د �� 4!/��ت اK/� روR ه� �7	/� 

 �/!i پ ��دن(را از�O، ���Hذ ، ، ��ز در ���ض د	� 
!�)ا	�Xد
.�kار �� ده�


� �� در �g	�Word Optionsاز i!/� ا	+ 6m	�1 ه��� �� +
��.ا	+ �k ��X1gار دارد �� �/�5 �� روI Rن ��X1g د	��R ��ز

�/�j� ت��K�ZH �� د�
 ����ط �� ه� �7	^ را در Iن ���ه�� 
��1� ��.

��
��� hindiا�m ا4�اد رادر ��� �� ��
. �kار ده�� ا4�اد در ��+ �7ر#� �� �Kرت �7ر#� ��

در� � �Oپ ���7ل ه��ioffice 2007را كافي است تغيي رات زير

.اعمال كنيد

Word Options → Display      

 دو ���, رو��و را

.5O ��ر� ��6��

�� در�%��� P��%� �2007�ر��office 

. كليك كنيدInsertابتدا روي كلمه.1

. را كليك كنيد Equationدر گوشه سمت راست منوي اصلي كلمه

پ.2 . ظاهر مي شود ،جمله را پيدا كنيدEquationايين كلمه در انتهاي پنجره اي كه در

و فرمول هاي شما درون آن نوشته مي شود.3 .با انتخاب اين جمله مستطيل كوچك آبي رنگي در اختيار شما قرار مي كيرد

و متن abc  Normal Textدر گوشه سمت چپ بالا، فرمول را از نوع.4  در نظر بگيريد،كه فونت فرمول

. مي شوديكسان
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.جهت چاپ فرمول هاي رياضي كه نوشته ايد انجام تغييرات زير ضروري است.5

1�. را �/��1� 5�Word Options از  Displayگزينه	�g ,k�� و در �	�!� �T)K ن درI �	�!� ر��ا#�H �!
 ���I


�د �� +���L �X1	،در ا ���اين دو مربع حتما تيك خورده باشند.��دن ه$.

و فرمول ها بايد در محيط تغييراتي . اعمال شودisioV كه براي فارسي نوشتن اعداد

 ديده office 2007 كار مي كنيم ،در فراخواني پنجره ظاهر شده با پنجره اي كه در  Visio  2003چون با نسخه

، فرق مي كند خصوص داده بنابراين لازم شد كه تذكراتي هم به صورت تصويري در اين، مي شود

.شود

،Wordمربوط به فرمول نويسي در اگر آيكن  را ،در نوار منو ،مشاهده نكرديد

 شما كامل نصب نشده باشد ،برنامه از شما سي دي Wordاما اگر.مي توانيد آن را فراخواني كنيد

Officeرا براي نصب مي خواهد .

اسروش فراخواني .تبه صورت تصويري نشان داده شده

.را به طرف نوار منو درگ كنيد از پنجره فوق آيكن

 پنجره اي به صورت زير ظاهر مي گردد كه شما،با كليك بر روي اين آيكن

.را قادر مي سازد فرمول ها رياضي را بنويسيد
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 نوشتن شما استهمزمان با ،باز شدن پنجره ،مستطيل كوچكي در اختيار شما قرار مي گيرد كه مكان نما منتظر

در اين پنجره اشاره گر ماوس را بر روي

پرانتز قرار داديم كه تمام حالتهاي 

.ممكنه را مي بينيد

و بعد از تغيير دادن مي توانيد با كليك دكمه با باز شدن پنجره زير مي توانيد اندازه اجزاء يك فرمول را جداگانه تغيير دهيد

Applyتغيير مناسب بود دكمه اگر. نتيجه را ببينيد Okرا انتخاب كنيد .

، متغيرهاوفرمت كاراكترها را تعيين كنيد،در اين پنجره مي توانيد زبان ، متن .. فونت توابع
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.در پنجره زير فاصله دو ستون را تعيين مي كند.فاصله اجزاء يك فرمول را مي توانيد بدلخواه تعيين كنيد

، فارسي نوشت؟ Visioدرگونه مي توان اعداد را در نوشته هاي معموليچ ،مانند طول يك پاره خط

 قبل از هر كاري بهتر است كه تغييرات زير را  Visio  2003بعد از وارد شدن به محيط

.اعمال كنيد

زبان را كليك كنيد ،پنجره اي ظاهر مي شود كه در آنجا مي توانيد نوع propertiesاگر.1

.انتخاب كنيد) Persian(را فارسي

R ��ز را انتخاText ،گزينه Format از منوي.2 ��X1g در �� �ب �1�


�� �� �Lا��� ��7� ��رد ��� را ا���jب �1��.

3.�.ه!���8ر �� ���ه�� �� �1��،در �g	�+ ��در ��ع ز��ن �7ر#� ا���jب 
�� ا#
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word �( ��'T ا���ل 1��4)� ا��S�ل

�L ^N#�!� را �� ا#�(�د� از روش �!
 �mاcopyوpaste  �	 و ��m6ر� ^N
 �N1	و� �� اM4،��1� ^.�1� ^	�7 �� 
�$�� Qه �	�i ���i ^��k، د�
 �� ��NO��.

.��اR ر7, ا	+ ��N^ ��ا�^ ز	� را -� �1��
١(��1� �
N^ �/�5 را# Rرو.
٢(
 و �� ا	+ ��ر � 6m	�1 ��� را ا���jبk�� ��7�� �� را ^N

.�������L ا��.�ل ده��
٣(^N
در �i	� �� ���ز �� 

 pasteدار	� ،
N^ را 
��1�.


�1� 5�/� ^N� �L د#����� ه�	� ا-�اف.(
N^ را در ���� ا���jب ��� دار	�)± Rرو
.)Iن د	�� 
�د

²(]#�L �� �/	�7 در offic e  2007 ر د 
�د �� د�~�ل �/!�ت ز	� �� ��
�� �T)K RU�� 
��د	��.

Page layout →Text wrapping 
³(R�1 ه�	6m از �N	Text wrapping��1� ب�j�ن ا��Lز��� �� ��را �$ .
٧(��1� �i ���i ��ا��L �� ��را �� را� ^N
و.��� از ا	+ 4!^ ، ^N
M4و� �� ا	+ �� ا���jب 

��� ،ا��از� 
N^ را ا#�(�د� از د#����� ه�	� �� در ��Oر -�ف Iن ا	�Xد �� 
�د �� �Lا
.�L��� ده��
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��ل�:��� Q�� 5	 Q#ر 

File → shapes→ visio Extras→Drawing Tools Shaps   

 

١.+N	I (�د� از�ا# �� Rر�� ]�T� 5 �!�ن �� درون	
.درگ �1��

) در�١٨٠�i!�ن .( �� ���� �.�8 زرد ر�� �!�ن را �� ا��از� ��Q دا	�� �6رگ �1��.٢

٣.+N	I �� �#  	5 دا	�� -�رR ر#Q �1�� �� دو �8k �8# �� دو

ن . او��� �81~� 
�د �!�
 .).را �L �.�ط دو #� �!�ن ��N�����, ه�6��k R ر��(.±
.�� �i ���i	� �.�8 زرد ر�� �� �Lا��� دا	�� را �� ��{� �L��� ده��.٥
ه.٦ و �� ���� �.�8 زرد دو #� ��8kن I	N+ ر#Q �1�� ،ا��!	5 دا	�� د	�� را ��  را �� روT� R�[ دا	�� �kار ده��


N^ ده�� ���L �}�� �� ا��I ر��.
و 	� �8k را ر#�1� Q���Drawing ا#�(�د� از ا�6ار.٧ ��ع
 .

� ه�	� از 
N^ را �� �� �Hاه�� �� �Kرت Trimاز د#��ر.٨!$k و  ا#�(�د� ��د�
.�.O �8�+ در Iور	�،�L��� ده��

ه(  �8Hط را از ���� �.Trim �8!�ن ا���ا �.�ط را �.O �8�+ ا���jب �1��،د#��ر ا�m از
و �� �Kرت #��g�� �L��� �� ده� .)�H +�Oرج �� �1�


�د ،����1ا	+،ه!���8ر �� �� دا��� ا�iاR ا	+ د#��ر �� ^N

�ن  ��8k ��8k �4�� �� � ه�	�!$k دن�� +�O �8.� در
�� ��1�U،زم ا#kا#��� �.�ط از ا�6اره�. د +�
�� Rاز� ه�و ��ا�... ،ا��(�د� �1��ا#.
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��ل�:Q#5 ر	8, .� Y8#ا��jد� ��4�k �� ��1ر� 

. 	5 �$�8�^ ر#�1� Q���Drawing ا#�(�د� از ا�6ار

)��/� ،���� دار	���ShiftاR ر#Q ���, ،ه!��6ن �� ر#��O Qر �/� +�	�g را (.

 ه$��� ،���7 ا#� �� ا
�ر� �m ��وس را 1O� ���T ا�H �mاه�ن ��Oر �/�� �j�/� اM� Uع
]�T� Rرو �� Rا ��	دا Rه� �������NO ��ه�و ����� ��Oر �/�� �kار ده�� �L د#�

راا�m دا	��.را �� �N� ����Lن ده�� ،
�ه� I ����Lن �/, �� 
�	�از ���, ه�5O�� R ه� ��ام.
�د 5O�� ����L 
.�� �� �1� ��K �� ,/رت ��1T1 وار I،��Lنده��


N^ را �!� دوران ده��، Rا ��	دا ���� �� ا#�(�د� از د#��ر.�� ا#�(�د� از د#�

)Copy-Paste(٣��
�� ��
. �L از 
N^ را در �T�[ ��رR ��	� دا

��. 	H 5[ را#� ر#�1� Q���Drawing ا#�(�د� از ا�6ار L!�م 6m	�1 ه�R ����ط
Snap &Glue 5	6د� �� �L ��1� ل����دن ر��س ا
�Nل �� H[ ،��ون ه�· را 7

، �/N�����
 ^Z�� Qه ��.

��1� ^Z�� Q�� را ���{� از �8Hط را �.O �8�+ �1��.ر��س د	� �	�� ^N
QX� R دار ���ن دادن  .ا�� ��ا

و ���g �8طH دن�� +�O �8.� Rر ...��ا��از د#Trim (�د��ا# �ا.�1��i Rه� ]H ر��g �� ه� را ��از ه~L Q�	��O ^ر �/

�� ا�� ،�� ر�� �� ا�iاR ا	+ د#��ر،. �L �/, ه��g R�� را �� �Kرت �.O �8�+ در Iور	��1�� ��L!��� #���8 �� ر�


�د ��.


!� د#��ر �N1	ا ��Trim ��، �ا� ��
را ��Nر ��د� ا	� ،ا�� ��{� از �8Hط ه$�1� �Oن �� ه�· H[ د	���H�� Rرد ��ا
ا ���� Q�$.L ��NO�� ت��8k��.

�1���^N
�^.i ]H/�	� هI �� Qن ا���jب �� 
�د رو��و �� �� �Hاه��g ,/� Q�� را �.Q�1� +�O �8 ،ا��  :را�

�� دار	�� ��T� �1O 5O�� ,��� Rوس را رو�� �m ر��

!� ا.�� ��$� ���
	�N از ���, ه��NO�� R را�� ��ه� �� 
 ,��� �L و ����1ر�R��ز�Lن ا���jب/� �N	ر�- ���N� �� 
�د، �oف را +�O �8.� ��اه�H �!� ����1�.
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�k�� ]H.]H ����� را �� �Kرت �.O �8�+ در Iور	� �� �� �oف ��د�)line Tool( ا�� �� ا#�(�د� از ا�6ار/� R�i �� 
��1� Q#�8 را رH �	ا.

����Oر �/�� و#�8 را �� �Hاه�Q ر�
Q�1�.از ا�6ار)Fill Color(Q�1� �� د��)�#ا .

� Trimا�� �Oن د#��ر��� Qدرو#[ ���1ر ه �� را ��Nر ��د� ا	��O، Qر �/
�� را از د#� داد� ����1ا	+ Uزم ا#� �� �� ا#�(�د� از ��اد از ا�6ارOر�g 5	

Drawing��1� ب�j�دور ا� �L ن را دورI .+�

� �� ��دا�� ��$� �!
 ����� �mا
��. ه!��� #8^ ر�� �� 
�دد#� از روR ��وس ،��O Y8#ر �/

���
� ه�	� از 	���� ��1gن �� !$k ��ا�� �� ر�� 
�ن ��Oر �/
و �oف ���� ا�� �/�N در  ،ا�� �� دا��� �� ا	+ �8Hط و�iد دار��

�1�$�� �!
�� روR. را ��Nر ��د� ا	�O TrimQن د#��ر.���ض د	� 
و ��1� �� ه�	� �� Uزم �� ���1� �� �Lا��� �/�5 را#!$k 

Bring to Front از  ا���jب ��1�6mShape	�1 را

Rا ��	دا ����و ا�H �mا#��� از د#� �m ^!4و� �1�R را ا��Xم ده��
.��اR دوران 
N^ ا#�(�د� �1��

.	5 �!��� د	�� از ���1ر را �� ��1��
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��ل� :Q#ع رMع ا��)Lرد ار�H�� ^T� �/� د��jا�در 	5 �

File → shapes→ visio Extras→Drawing Tools Shaps   

 +N	I (�د� از�در �$�� �7ق �� ا# Qه ا ر#�8H Q�1� �� Qط 4!�د �� .ر

١.Q�1� �� Q#ا� را ر�jع د�Mا� �� ��/�.ا���ا �

. را �� �T�[ ��رR درگ ��1�perpendic… linesا�6ار.٢

�� �� �� �Hاه��.٣/� Rدو ���, #~6 ر�� را، �� رو�ار ده��k،د�
.از راس �.��^، ارL(�ع �� Iن وارد 

.���, زرد ر�� را �� روR راس �.��^ �/,، �kار ده��.±

�K ��(,/� ��BCرت �.�8H A)+�O �8 را از راس Drawingا��1ن �� را��� �� �Lا��� �� ا#�(�د� از ا�6ار.²
��1� Q#ر.

و �oف �1�� را ا��perpendic… linesjدر �g	�ن ��ر ا�6ار.³ در ��� ا	+ �Kرت در ��k, ا��.�ل �� �7	^ .( �ب
Wordد�
و ارL(�ع دو  �8H	� �g ر�� د	�� ��  �/�.) 	�N از ا�Mع �

.��اR دو �/, د	�� ،ا4!�ل �7ق را ا��Xم ده��.٧


N^ ر#�1� Q��L ��،ا��� از ا�6ار.٨ Rرو ، Qرا ه �!��k �	!�ن زاو� �� �اه��j� �mا 

.ا#�(�د� �1�� در ه!�+ �$��
A

B

C

H

k

j
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.�kار ده��و �/, Iن را �� رو�H�� ^T� Rرد ارL(�ع راس

 را ��5O �1�� و�� �H�O ���, زرد ر�� ،�!�ن �i �� �i ��Perpendic…angle ��دن ���, ه�R #~6ر�� ا�6ار
��1� Q��1L ��اه�H �� �� Rا �	زاو Rرا ��ا �!��k �	زاو.

-' 3'�,4 Style )@%QV T���%ن�� ، ، ا���ل � '- ��م �Y6R ���6%ا
 *�ر��)1�ت �V%طZ4

��	� ��د� ا	�L د�H ا��j��� ^��#5 ا	 �!
.ا��1ن 

��1� V	�L �X1	اه� را در ا�j+.��م د�	ا ��
�oارR د�!����Addد�
. �gر�� �� 

و ]H و g¡ از K�ZH����L��ت ��+
 را ا���jب Addر�� ا
�Nل، د�!� 


��1��L،ا#��^ ��
 �	��L R���$�� �� �!
.k~/� ا���7 
�د

R�¹¹د�!�¹¹ هFill,line,Textا� ��¹¹jب را
و  و �����R�¹¹¹ د��¹¹¹jا� را ا���¹¹¹jب �¹¹¹�1�

 ��1� W���L.�¹5¹ ��¹ر� هO +�
 �� ��دا
��1� �!� �	��L /� را��ا# �!
.

١

٣
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�1	6m و ��1� �
N/� �� ر#Q 	� درگ ��د	� �/�5 را# Rرو ��Styleاز ��م از ��X1g ��ه� 
��.ا���jب ��1�Format را

�� �Hد�Lن را g��ا �	��L ^��#ا�ب �1��j�و ا�.

�� ���� ا	R����L �N1 �� روR ا
�Nل ا4!�ل ��1���L �!ا��� در ��ار �Formatting  ،�1ا�6اره�R ا�� �� ا	+ 4!^ د	�،
. در ��� ����	�Normalرا از ��عه� LStyle!��� از ��X1g �7ق 

→Tools حركت يك شكل Add_ons→Visio Extras →Move Shapes 

Q	دار ^N
 ���� Rا�� �.ه!���8ر �� ���ه�� �� �1�� در ��X1g رو��ودو ���

١.Rو 4!�د 
�K �� ^Nرت ا7.� � .) را ا���jب �1��( ���

.�و رادر ���� ا���jب �kار ده�� 
N^ رو�ا���ا

R 
�+ ا4�ادR درون ��دره��� �� Horizontal وVertical و 
�O �� ^N ا��از� در را#��R ا7.� �� ��1� �j��،
�1� ���� R4!�د.


N^ او��� در �� �/K�7
 R��#ا7.�را 


N^ او��� در �� �/K�7
R4!�د R��#را 
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��
��، د	�� �� 
���، را ا���jب ��1� Duplicateا�m در ه� دو ��� �i ���i ^N

N^ او��� ه!�ا� �� .

و 
N^ او��� در را#��R ا7.� �� �~$� R��� Rه� ^N
 ��
� ��د� ��kد �mا���
و 	� ��� ��  �11� �� ���� R4!�د.

٢.�/K�7 و � زاو	�TL ^N
 ���� 


�K �� ^Nرت دورا�� ا#�(�د� ��دHاز ا	+ ���NL Rان ��ا�L �� ��K� .

از. در�i ا#�٣³٠ه!���8ر �� �� دا��� 	5 دا	��:���ل Q�اه�j� �m5ا	^N
 دا
�� �� �Kرت دا	�� وار ���³ 
�،Q�
�� �!$k رج�H ���³ �� �7�٣³٠ ا# Q	ورI �� �� I	�³٠ را ��##�� .�1� در³٠�i ��ر از 
N^ او��� �� زاو	�³	


N^ دو�^ ���� ده��.T� و 	� ا	�N1 دا	�� اR را �� ا��� ��1� ^Kل ا��� را �� ���6 و�N
[ 	� ��Tط�g¡ از ا	�Xد ��دن ا
��1�.


N^ او���زاو	� �� 
N^ او��� �� �/K�7
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